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Overview

SnagIt is the screen capture and print program for Microsoft Windows 3.0.  
With SnagIt, Windows users can capture an entire screen, a portion of the 
screen or a single window or icon.  SnagIt sends the captured area to a 
printer, the Windows clipboard or a file.  These images can be pasted into 
other Windows applications such as word processors and desktop publishing 
programs.

SnagIt provides a simple solution to the problem of importing high quality 
Windows screens into documentation.  SnagIt is a practical, easy-to-use 
addition to the programs and tools utilized daily by Windows users.

SnagIt allows documentation writers to cut and paste Windows screens into 
user manuals, marketing literature, advertisements, newsletters, and other 
documents.

With SnagIt, Windows programmers can quickly create printouts of program 
screens, windows, and icons for presentation and review.

SnagIt provides screen print capabilities for other Windows programs.  
Programmers developing applications with Microsoft Excel macros, Gupta's 
SQLWindows, Asymetrix's ToolBook, and other tools, can activate SnagIt with 
dynamic data exchange (DDE) messages.

SnagIt provides DOS users with print screen capability for applications 
running in a DOS session under Microsoft Windows.
About this Manual

This manual shows you how to install and use SnagIt and is divided into 
three sections.  
In the first section, Installation:
· Computer system requirements are listed.
· Setup instructions describe how to install and configure SnagIt.
· Getting Started teaches you the basic operation of SnagIt.

The second section, Reference:
· Describes program operation, menu selections, and options available in 

SnagIt.
· Keyboard operation and mouse controls.
· Input, output, format, and option menus.
· Shows how to save the SnagIt's configuration.
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The third section, Dynamic Data Exchange (DDE):
· Explains how to use DDE messages.
· Contains the DDE reference that lists the DDE commands supported by 

SnagIt.

Appendix A of this manual lists other products available from TechSmith 
Corporation.
This manual was created using SnagIt and Microsoft Word for Windows.
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Installation

To use SnagIt, you need:

· An IBM PC or 100% Compatible
· Microsoft Windows 3.0 
· A mouse or other pointer device
· Any printer that supports bitmaps such as an HP LaserJet or a Postscript 

printer

To install SnagIt:

1. Insert the SnagIt diskette in drive A: or B:.

2. Start Microsoft Windows.

3. From the Windows Program Manager, choose Run from the File menu 

4. On the command line type a:setup or b:setup, as appropriate

5. Press Enter.

The following dialog box is displayed.

(Not Shown in Write)
The SnagIt installation dialog box

6. Enter your name and your company name in the User Information 
group box.

7. If you want SnagIt to load automatically when you start Windows, click 
on the check box in the Load information group box.

8. If you want to install SnagIt to the Window's default directory and the 
Accessories group, choose Ok.

If you wish to install SnagIt to a different directory or group than 
shown, enter the name of the new directory or group name and choose
Ok.

Note: If you leave the group option blank, SnagIt is not installed in any group.
In this instance, you can run SnagIt using the File Run command from the 
Windows Program Manager.
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Getting Started

In this section you will learn how to use several of the basic features of 
SnagIt and create your first screen print.

1. Start Microsoft Windows.

2. Pick on of the following:
a) If you configured SnagIt to load automatically during the setup step, 

you will see the SnagIt icon displayed at the bottom of your screen.
b) If you did not configure SnagIt to load automatically, load SnagIt by 

selecting the SnagIt icon from the group selected during Setup.
c) Execute File Run from the Program Manager and enter the path to 

SnagIt and press enter.

You can use SnagIt to print the entire screen, a selected region of the screen 
or a single window.  Our Getting Started example will show you how to select
the input and output choices to send a full screen to the printer.

First, restore SnagIt by selecting the SnagIt icon.

(Not Shown in Write)
SnagIt Main Screen

The SnagIt window shows the menu and the current settings for the program
choices.

For our example select the Input menu item to view the list of SnagIt input 
choices and select Screen as the input region choice.

(Not Shown in Write)
SnagIt Input menu

Select the Output menu item to view the list of SnagIt output choices and 
select Printer as the output destination choice.

(Not Shown in Write)
SnagIt Output menu

To start the capture process, send the screen to the printer, press [Ctrl]
[Shift]P simultaneously.

While SnagIt is busy printing the following message box is displayed.
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(Not Shown in Write)

To cancel the printing operation, select the Cancel button in the message 
box.  A message box will be displayed with the message "Output canceled by
user."  If the printout is canceled a portion of the image may have already 
been sent to the printer and will print.

To illustrate a second SnagIt feature, select Region from the Input menu 
choices.

Press [Ctrl][Shift]P simultaneously.

The cursor will change from an arrow to cross hairs.  Use the cross hairs to 
select a region by holding down the left mouse button and dragging the 
cross hairs to the lower right corner of the region you wish to capture.  
Release the mouse button.

The region you selected will now be output to the printer.

Complete descriptions of the menu options are available in the Reference 
section of this manual.
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Reference

This section of this manual describes the mouse buttons, keyboard 
commands, and the features and options of the SnagIt program.  

The following command line arguments control SnagIt's startup.

/nokey or /n Disables keyboard input.  For use with DDE.

/hide or /h Hide the SnagIt window at startup

A mouse is required when using SnagIt.

Left Button - The left mouse button is used to select SnagIt menu options 
and to select screen regions and windows.

Right Button - The right mouse button is used to cancel a region or window
selection.

The following keyboard commands are used in the operation of SnagIt.

[Ctrl][Shift]P - Activates SnagIt printing.

[Ctrl][Shift]X - Makes the SnagIt icon or window disappear from the screen.
Pressing [Ctrl][Shift]X a second time causes the icon or window to 
reappear.

This section describes the operation of each command on the SnagIt menu 
bar.  The SnagIt menu bar has five choices: Input, Output, Format, 
Options and Help.

The Input option allows you to select the particular screen image, 
icon, window or bitmap file or clipboard content that you want SnagIt to 
capture.

The Output option allows you to select an output destination for images 
captured by SnagIt.  Output options include the printer, a bitmap file, a 
monochrome TIFF file, or the Windows clipboard.

The Format option allows you to change how the SnagIt image will appear in
finished form: monochrome, color, or gray scale.

The Options choice allows you to select from a number of additional 
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features offered by the SnagIt program including alert beeps, color boost, 
scaling, and clipboard chaining.

The Help option provides information about each menu selection.
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Input

The Input menu is used to select the screen, window, or bitmap file or 
Windows clipboard content that you want SnagIt to capture.

(Not Shown in Write)
SnagIt Input menu

1. Select Input on the SnagIt menu.  

2. Select from the following options.

Select Screen to capture the entire screen.

Select Window Client Area to capture only the client area of a single 
window.  The client area is the content area inside the window borders.  The 
client area does not include the borders, title bar, menu bar, scroll bars or 
the caption line.  

After you press [Ctrl][Shift]P, select the client area you wish to capture by 
positioning the pointer anywhere in the client area.

Press and release the left mouse button.

Select Entire Window to capture a complete window including the borders, 
title bar, menu bar, scroll bars and the caption line.

After you press [Ctrl][Shift]P, select the window you want to print.

Press and release the left mouse button.

To select the window you want, not smaller windows such as buttons or 
icons, select the title bar.  Items within a window, such as the Ok and Cancel 
buttons, are actually small windows.  Therefore, if you select one of these 
items, that item will print, rather than the entire window.

Select Region to capture a rectangular region of the screen.

After pressing [Ctrl][Shift]P, position the pointer to the upper left corner of 
the region to capture.  Press and hold the left mouse button while you drag 
the pointer to the lower right corner of the region.  A rectangle starting at the
upper left corner will follow the pointer, outlining the selected region.
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Release the mouse button.

Select BMP file to capture an image stored in a bitmap file.  

When you press [Ctrl][Shift]P, SnagIt displays a dialog box requesting the 
file name.  

Enter the file name.

Choose Ok or press Enter.

Bitmap files are graphics files generated by some paint programs, SnagIt or 
other Windows programs.  Bitmap files have a file extension of "BMP."

Select Clipboard to capture the contents of the Windows clipboard.  Items 
are placed on the clipboard by using SnagIt or the cut and copy commands in
other Windows programs.  
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Output

The Output menu is used to select the destination for the images captured 
by SnagIt.  SnagIt supports the following destinations:

(Not Shown in Write)
SnagIt Output menu

Choose Printer to send the captured image to the currently selected 
Windows printer.

Choose Clipboard to send the captured image to the Windows Clipboard.

Choose BMP File to send the captured image to a bitmap file.

Choose TIF Mono File to send the captured image to a TIFF file in the Intel 
format.

Note: To select TIF Mono File, you must first select monochrome or gray 
scale from the Format menu.

After you capture an image, SnagIt displays the following dialog box asking 
for a file name.

(Not Shown in Write)

Enter a filename.

Choose Ok or press Enter.
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Format

SnagIt provides three different format options:  Mono-chrome, Color, and 
Gray Scale.  Select the format choice from the Format menu.

(Not Shown in Write)
SnagIt Format menu

The following format choices are provided.

The input image is converted to monochrome before it is sent to the output 
destination.  The intensity threshold level determines the amount of black 
and white that will appear in the output image.

When you select Monochrome, the following dialog box for setting the 
Intensity Threshold is displayed.

(Not Shown in Write)
Intensity Threshold dialog box

When Microsoft Windows converts a color image to monochrome, it converts 
the background color to white.  All other colors are converted to black.  As a 
result, too much of the image is now black.  To prevent this, SnagIt uses an 
intensity threshold to control the ratio of black and white resulting from the 
conversion process.

SnagIt looks at the intensity level of each pixel and converts higher 
intensities (lighter colors) to white and lower intensities (darker colors) to 
black.  This conversion process usually results in a more even balance of 
black and white in the output image.  The amount of black and white is 
controlled by adjusting the Intensity Threshold value.

All color information for the selected image is sent to the output device

Gray scaling is an alternative to monochrome conversion.When Gray Scale 
is selected, colors are represented by shades of gray.

SnagIt can represent colors with 256 levels of gray.  The shades of gray are 
determined by the intensity level of the colors.

Caution: Gray scaling is a pixel by pixel process and can be very slow.  You 
may want to experiment with gray scaling by printing a small region of the 
screen before printing the whole screen.  You may also want to enable the 
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Alert feature under the Options menu to let you know when the gray 
scaling process is completed.
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Options

The Options menu provides additional features for SnagIt users:  Alert, 
Clipboard Chain, Color Boost, and Scale.

(Not Shown in Write)
SnagIt Options  menu

Set the Alert option to have SnagIt signal you with a beep(s) when it has 
completed processing.  There is an alert option for both input and output 
processing.  The values entered for these fields determine the number of 
beeps.  This feature is particularly useful when using the Gray Scale option.

(Not Shown in Write)
Alert dialog box

Setting the Clipboard Chain option causes SnagIt to print each time new 
information is sent to the clipboard.

Clipboard chaining is useful for printing a screen from a DOS session.  When 
you press the [Print Scrn] key in a 

DOS box, Windows copies the screen to the clipboard.  If you have selected 
the clipboard chain option, SnagIt automatically copies the image to the 
printer for you.  

Note: To select Clipboard Chain, the input device must be set to 
Clipboard, and output device must be set to Printer.

Color Boost is used to adjust the color intensities for red, green, and blue 
portions of each pixel.  This option may be used for color separation, 
brightening, or darkening the output image.  When Color Boost is selected, 
a dialog box is displayed for color boost values.  

(Not Shown in Write)
Color Boost dialog box

You may control the intensity for each pixel in two ways.

1. Increase or decrease intensity levels of each color by a percentage 
(saturation) by using the slider bar. 

2. Add or subtract intensity levels (hue) for each color range by entering 
a value from -255 to 255.
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The default value for each additive range is zero and the percentage bar is 
100%.  

To activate color boost, click on the "Use Color Boost?" check box. 

Color boost is used to change the intensity of the colors.  Increasing the 
boost value lightens the output.  SnagIt performs color boost before gray 
scaling or monochrome conversion.  Therefore you can use color boost to 
lighten or darken the output with those options as well.

The Scale option allows you to enter an integer scaling factor that is applied 
to the input image.  With a scaling factor of 2 the output image will be 
double the size of the input image in dots.  With a 300 dpi laser printer, a 
scale of three (3) is a good place to start.

(Not Shown in Write)
Scale dialog box

Save Setup

SnagIt can save all of the currently selected options from each SnagIt menu. 
The Save Setup option is located under the System Menu.  

(Not Shown in Write)
SnagIt System menu

You can access the System Menu by pressing [Alt][Space] or by selecting 
the Close Box (minus sign) in the upper left corner of the SnagIt window.

Save the current configuration by choosing Save Setup from the System 
Menu.

When you save the setup, SnagIt writes all of the current settings to your 
WIN.INI file.  SnagIt then uses the saved setup each time it is loaded until 
you save different settings.
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Dynamic Data Exchange

SnagIt supports Windows Dynamic Data Exchange (DDE).  You can invoke 
SnagIt from other Windows programs by sending SnagIt DDE Messages.  For 
instance, you can write an Excel macro that will print a portion of the screen 
using SnagIt.  For more information concerning please see the DDE section in
the Software Developer's Kit reference book "Windows Guide to 
Programming."

To initiate a DDE  session with SnagIt, send a DDE_INITIATE message with the
application parameter of "SnagIt" and the topic parameter of "System".

SnagIt's DDE_EXECUTE Set command or DDE_POKE commands configures 
SnagIt's operation in the same fashion as though choices were being 
selected from the menus.

Usage: DDE_EXECUTE

[set ("string")]

Usage: DDE_POKE

"variable", "value"

Example: Set the Input menu choice to Region.

[set ("input region")] (DDE_EXECUTE)

"input", "region" (DDE_POKE)

The parameter string must be one of the following strings.  The variable 
names are italicized.

input screen (input = screen)
input client (input = client window)
input window (input = entire window)
input region (input = region)
input file (input = BMP file)
input clipboard (input = clipboard)
scale n (option scale = integer > 0)
output printer (output = current printer)
output file (output = BMP file)
output clipboard (output = clipboard)
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chain bool (option chain = True or False)
boost red, green, blue (option boost = Enabled)
boost off (option boost = Disabled)
add red, green, blue (option boost = Enabled)
add off (option boost = Disabled)
inalert n (option alert input = value)
outalert n (option alert output = value)
window hide (hide SnagIt)
window show (unhides SnagIt)

SnagIt's capture process is started by sending a DDE_EXECUTE command 
with Snag message:

Usage:
[snag("string")]

Example: Snag the client window, handle 0x43B, to the selected destination

[Snag ("client handle 0x43B")]

The string parameter must be one of the following:

empty or null (equivalent to [Ctrl][Shift]P)
clipboard (get image from the clipboard)
screen (get the image from the screen)
filename (get image from BMP file)
x y (get entire window under the point)
client x y (get client window under the point)
handle h (get entire window from handle)
client handle h (get client window from handle)
tx ty bx by (get region between two points)
exit (terminate SnagIt)

Note: All numbers may be decimal or hexadecimal.  Hex values must start 
with "0x."

Getting SnagIt's status is accomplished by using sending a DDE_REQUEST 
command with Status.  SnagIt will return either Ready or Busy.

Ready: SnagIt is ready for another command.

Busy: SnagIt is currently processing the last command
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Appendix A
DDE Watch

Dynamic Data Exchange Monitor
Dynamic Data Exchange (DDE) is the way that today's powerful Windows 
applications communicate.  Until now, you could not monitor these DDE messages 
or validate your DDE macros and programs.  Now there is DDEWatch, a tool to let 
you see DDE.  With DDEWatch you can scrutinize each DDE message, concentrate 
on selected DDE sessions, learn the DDE protocol, and improve the quality of your 
code.

View DDE Messages in Detail
DDEWatch gives you a window into the world of DDE messages.  With it, you can 
view the details of any DDE message.  DDEWatch displays the message type (e.g. 
initiate or ack).  The name of the application, topic, or item and the symbolic name 
of each bit-flag are also displayed.  You can even see the data in execute, poke, and 
data messages.

Locate Active DDE Sessions
Frequently DDE sessions run simultaneously which can be confusing.  But 
DDEWatch provides you with a list of all active sessions.  From this list, you may 
select to view messages for only those sessions in which you are interested.

Learn DDE
With DDEWatch you can learn the DDE protocol by observing interactions between 
programs like Excel and Word for Windows.  You will see how the initiate is 
broadcast to all applications, how an advise is usually followed by a request, and 
how two applications negotiate a common data format.

Improve Program Quality
Using DDEWatch, you can improve the quality of the macros and programs you 
write.  For example, you can verify that the flags are set correctly, the memory has 
been properly allocated, and the data is correct.  Then you can document this 
quality by logging the DDE messages into a file.
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DDELib
A Library for Implementing DDE
DDELib is a dynamic link library for Microsoft Windows 3.0 programmers who are 
developing dynamic data exchange (DDE) applications.  This library provides a set 
of software functions that implement the complex details of the DDE protocol.  By 
using DDELib, application developers can quickly and easily generate powerful DDE 
software.

Saves Time
DDELib saves time because it frees programmers from many details of the DDE 
protocol.  Memory management tasks are simplified, and the need to process DDE 
messages, issue acknowledgements, or handle atoms is eliminated.  As a result, 
programmers can concentrate on processing data, not DDE.

Easy to Use
DDELib reduces complex tasks to simple function calls by providing an intuitive 
application program interface.  For example, the code fragment:

hDDE=DDEInitiate("Excel","sheet1");
initiates a DDE session with Microsoft's Excel.  All functions provided by DDELib are 
clearly documented, making DDELib easy to use.

Powerful DDE Support
DDELib performs advanced DDE communications.  For example, DDELib supports 
the fAckReq flow control strategy, the fDeferUpd warm and hot links, and any valid 
setting of the fRelease memory management scheme.  DDELib provides 
functionality beyond the DDE protocol, including a facility to keep track of active 
advise circuits, which is useful for developing DDE server applications.

Includes Sample Programs
Sample programs included with DDELib illustrate how to use the library to build 
client and server applications.  For example, AccExcel demonstrates how to 
interface with Excel, while Session and SessUtil show how to build a server 
application that supports multiple clients.  The versatility of DDELib is shown by 
Sub, which operates a submarine in a fish tank.
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